XIl. Blocks

BLOCK AND WBLOCK

A block isa collection of objects you can associate together to form a single object, or block definition.
You can insert, scale, and rotate a block in adrawing. Y ou can explode a block into its component objects,
modify them, and redefine the block. AutoCAD updates all current and future instances of that block based
on the block definition.

Blocks streamline the drawing process. For example, you can use blocks to:

Build a standard library of frequently used symbols, components, or standard parts. Y ou can insert the same
block numerous times instead of re-creating the drawing elements each time.

Revise drawings efficiently by inserting, relocating, and copying blocks as components rather than
individual geometric objects.

Save disk space by storing all references to the same block as one block definition in the drawing database.

When you insert ablock in your drawing, you are creating a block instance. Each time you insert a block
instance; you assign a scale factor and rotation angle to the inserted block. Y ou can also scale a block
instance using different values in any coordinate (X, Y, Z) direction.
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Blocks make it possible for you to organize your drawing tasks in a systematic way, so that you can set up,
redesign, and sort the objects in your drawings and the information associated with them.

Y ou can group objects to create block definitions in the current drawing, or you can save the block as a
separate drawing file. When you define a block, you specify the base point, the objects to group, and
whether to retain or delete the objects or convert them to a block in the current drawing. Y ou can also enter
atext description and specify an icon used to help identify the block definition in AutoCAD Design Center.
Block definitions are one of many non-graphical objects saved in a drawing.

To create a block definition

=)

1 From the Draw menu, choose Block = Make.
2 In the Block Definition dialog box, enter a name for the block.
3 Under Objects, choose the Select Objects button to use the pointing device to select objects for the

block definition.

The dialog box closes temporarily while you select objects for the block. Press ENTER when you
are done selecting blocks. The dialog box reopens.

4 If you want to create a selection set, use the Quick Select button to create or define afilter for your
selection set.
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5 Under Objects, specify whether to retain, convert to ablock, or delete the selected objects.
» Retain: Keeps selected objectsin the current drawing, in their origina state.
»  Convert to Block: Replaces selected objects with an instance of the block.
» Delete: Removes selected objects after the block is defined.

6 Under Base Point, enter the coordinate values for the insertion base point or choose the Specify
Insertion Base Point button to use the pointing device.

7 Under Description, enter text to help identify the block for easy retrieval.

8 Under Icon, specify whether to create an icon from the block definition.
e Do not include an icon: Omits preview image from block definition.
e Createicon from block geometry: Saves preview image with the block definition.

9 Choose OK.
The block definition is saved in the current drawing.

Command line BLOCK

Related —-BLOCK creates block definitions on the command line.

NOTE To generate preview images for blocks you created with Release 14 or earlier, use the
BLOCKICON command. The command works on your current open drawing and prompts you for the
names of blocks that you want updated with preview images. For information about preview images (or
block icons),

To save a block or object as a separate drawing file
1 At the Command prompt, enter WBLOCK.

2 In the Write Block dialog box, specify a block or an object to write out as afile.
» Block: Specifiesablock to save as afile.
e Entire Drawing: Selects current drawing as a block.
»  Object: Specifies abjectsto be saved as afile.

3 Under Block, select aname from the list to save as afile.

4 Under Base Point, use the Pick Point button to define the base point.

5 Under Objects, use the Select objects button to select the object for the block file.
6 Enter a name for the new file.

» |f ablock isselected, WBLOCK automatically uses that block's name for the new file.
7 In the Insert Unitslist, select an insert unit to use in AutoCAD Design Center.
8 Choose OK.
The block definition is saved asadrawing file. This option is handy for inserting parts of one drawing into

another, especially when proper coordinate locations are important (i.e., bringing roads from one drawing
into another, and have them overlay existing drawing entities).

75



Block Objects

A block isa collection of objects you can associate together to form a single object. When you insert a
block in your drawing, you are creating a block instance. Each time you insert ablock instance; you assign
a scale factor and rotation angle to the inserted block.

Blocks streamline the drawing process.

Build a standard library of frequently used symbols.

Revise drawings efficiently.

Save disk space by storing all references to the same block as one block definition in the drawing.

Y ou can group objects to create block definitions in the current drawing, or you can save the block as a
separate drawing file. When you define a block, you specify the base point, the objects to group, and one
or more optional attribute tags.

STA 234

Typical Mapping Blocks

Block; Make @

Blocks can be defined from objects that were originally drawn on different layers with different colors,
linetypes, and lineweights.

When a block that consists of objects drawn on layer 0 and assigned the color, linetype, and lineweight
BYLAYER is placed on the current layer, it assumes the properties of the current layer.
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WBLOCK

WBLOCK writes selected objects from the current drawing to a new drawing file. Objects may be in the
form of ablock, or individual drawing objects. To copy objects from one drawing to another, acommon
base point (usually 0,0) must be used in both drawings.
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Using Blocks

Insert

Block instances are inserted into drawings, providing the location, scale (x,y,z) and rotation angle To insert
block data "un-grouped", check the explode option
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Blocks with Attributes
An attribute provides alabel or tag for you to attach text to ablock. Whenever you insert a block that has a
variable attribute, AutoCAD prompts you to enter the data to be stored with the block.

Extract attribute information from a drawing to use in a spreadsheet or database

Associate one or more attributes with a block

AutoCAD prompts you for the value of each attribute when you insert the block

Or, you can define constant attributes: because they have the same value in every occurrence of the block
Attributes can be invisible, which means the attribute is not displayed or plotted.

Attdef ©
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Blocks

A block isa collection of objects associated together to form a single object. When you insert ablock in
your drawing, you are creating a block instance. Each time you insert a block instance, you assign a scale
factor and rotation angle to the inserted block.

Drawings external to your working drawing, may be inserted as block objects. Block symbol libraries are
created in this manner.

Exercises

Exercise (4a)

Create adrawing to be used as a block, that once inserted, the block uses the current layer properties.
When objects are created on Layer 0, with color and linetype properties set to "ByL ayer", and the drawing
inserted as a block, the block inherits the current layer properties.

Create a new drawing (from scratch)
Layer
e Currentlayer=0
PL + (digitize a polyline using typed coordinates)

o+ -50,-50 +

« 5050 +

» Enter (+)
PL «

e 5050 #

e 5050 #

e Enter (+)

Save the drawing
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e Drawing name: X1
Closethe drawing.

Insert X1 as ablock into a new drawing and observe the block properties.

Create a new drawing (from scratch)
Open the Layer Propertiesdialog box
»  Click the“New” button
* Layer Name: Blue
e Layer Color: Blue
e Set Blueascurrent layer
* Click OK
Insert +
» Block Name: X1 (Click the browse button and navigate to the file created in the previous exercise)
» Insertion point: Check specify on screen
e Scae(xyz):1
* Rotation: 0
Open the Layer Propertiesdialog box
»  Click the“New” button
e Layer Name: Green
e Layer Color: Green
e Set Green as current layer
* Click OK
Insert <
» Block Name: X1 (Click the browse button and navigate to the file created in the previous exercise)
» Insertion point: Check specify on screen
 Scae(xyz):1
* Rotation: 0
Save drawing
» Drawing name: Bx1
Closethe drawing.

(Teaching point: insertion point of block, 0,0 from X1; inherited properties of inserted block)

Exercise (4b)

Create adrawing to be used as a block, that once inserted, the block objects retain their color and layer
properties as set.

Create a new drawing (from scratch)

Set the following on the object propertiestoolbar.
* Currentlayer=0
e Color = Bylayer

PL ' (digitize a polyline using typed coordinates)

e -50-50 #
e 5050 «
e Enter (+)

Open the Layer Propertiesdialog box
*  Click the “New” button
e Layer Name: Red
e Layer Color: Red
*  Current layer: Red
e Click OK
PL &
e 5050 #
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+ 50,50 +

e Enter (+)
Save the drawing

» Drawing name: X2
Closethe drawing

Insert X2 asablock into adrawing Bx1 and observe the block properties.

Open drawing Bx1
Set the following on the Object Propertiestoolbar
e Current layer: Blue
Insert <
» Block Name: X2 (Click browse and navigate to the drawing created in the previous exercise)
e Insertion point: Check specify on screen
 Scade(xyz):1
* Rotation: 0
Set the following on the Object Propertiestoolbar
»  Current layer: Green
Insert
» Block Name: X2 (Click browse and navigate t the drawing created in the previous exercise.
e Insertion point: Check specify on screen

e Scade(xyz):1
* Rotation: 0
Layer

»  Freezelayer: red
Save the drawing
Closethe drawing

(Teaching point: properties of inserted block)

Exercise (4c)

Create adrawing to be used as a block, that once inserted, the block objects retain their color properties as
set.

Create a new drawing (from scratch)

Set the following on the Object Propertiestoolbar
e Currentlayer=0
e Color = Bylayer

PL +! (digitize apolyline using typed coordinates)
e« -50,-50 +
« 5050 +
 Enter (+)

Set the following on the Object Propertiestoolbar

 Color=Red
PL #

e -5050 +

e 50,-50 +

e Enter (+)
Save

e Drawing name: X3
Closethe drawing

Insert X3 asablock into adrawing Bx1 and observe the block properties.
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Open drawing Bx1
Set the following on the Object Propertiestoolbar
e Current layer: Blue
Insert
» Block Name: X3 (Click browse and navigate to the drawing created in the previous exercise)
» Insertion point: Click specify on screen
 Scae(xyz):1
* Rotation: 0
Set the following on the Object Propertiestoolbar
e Current layer: Green
Insert <
» Block Name: X3 (Click Browse and navigate to the drawing created in the previous exercise)
e Insertion point: Click specify on screen
e Scade(xyz):1
* Rotation: 0
Freeze layer: red (from the Object Propertiestoolbar)
Save the drawing
(Teaching point: properties of inserted block)

Exercise (4d)

Objects may be grouped to create a block within your current drawing. Unlike the method used to build a
symbol library, these blocks are only available for use within that drawing.

Create a block by grouping objects within source drawing Bx1.

Open Drawing Bx1 if it isnot already open
Set the following on the Object Propertiestoolbar
e Current layer 0
»  Setcolor = ByLayer
Circle ! (draw acircle)
»  Pick the center point of the circle
* Diameter =50 +
Create a crosshair through the circle's center
PL &
e Quad +! (snap tothe quadrant of thecircle)
e Quad + (snap to quadrant opposite first point)
e Enter (+); to end polyline
PL &
e Quad + (snapto quadrant perpendicular to previousline)
* Quad + (snap to quadrant opposite previous point)
» Enter (+); to end polyline

Create a block from the newly created objects.

Block «
* Name=CX
e Click Pick Point; using the Intersection setting of Osnap, select middle of symbol.
e Click Select Objects; select objects to be grouped.
* Click Retain
* Click OK
Insert CX asablock into a drawing.

Set the following on the Object Propertiestoolbar
*  Current layer: Blue
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Insert <
» Block Name: CX
e Insertion point: Click specify on screen
 Scae(xyz):1
* Rotation: 0
e Click OK
»  Click apoint on the screen for the insertion point of the block
Set the following on the Object Propertiestoolbar
e Current layer: Green
Insert <
» Block Name: CX
e Insertion point: Click specify on screen

e Scade(xyz): 1
* Rotation: 0
e Click OK

»  Click apoint on the screen for the insertion point of the block
Save the drawing
Closethe drawing

(Teaching point: Creating a block within a source drawing)

Exercise (4e)

Blocks and or other drawing objects may be extracted to a separate drawing using Whlock, making them
available for use in other drawings.

Create a new drawing (from scratch)
Open the Layer Propertiesdialog box
*  Click the“New “ button
» Layer Name: BlockCX
*  Setlayer BlockCX = current
Insert
» Block Name: CX
» Block CX cannot be found. Block CX only existsin drawing Bx1 and is not currently available
outside of drawing Bx1. To make CX available to other drawings, use Whlock (write block) to
create a new drawing.
Exit drawing

Open Drawing Bx1
Whblock +!
*  Source: Objects
»  Click Pick point, Use the intersection setting of Osnap to select the intersection of the crosshairs
» Click Retain
* FileName: BlockCX.dwg
* Locdtion: ...\cadclass
* Click OK
Save the Drawing
Closethe Drawing

Block CX has now been saved as a separate drawing, and is available as a block to other drawings.
Create a new drawing (from scratch)

Open the Layer Proprieties dialog box
*  Click the “New” button
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e Layer Name: BlockCX
e Setlayer BlockCX = current

Insert <
» Block Name: Block CX (Click browse and navigate to the drawing created in the previous
EXercise)

»  Insertion point: Click specify on screen

 Scae(xyz):1

* Rotation: 0

* Click OK

e Click apoint on the screen for the insertion point of the block
Save the drawing

e Drawing name: whblockex
Closethe drawing

(Teaching point: Extracting a block to a separate drawing)

Exercise (4f)

An attribute provides alabel or tag for you to attach text to a block. Whenever you insert a block that has a
variable attribute, AutoCAD prompts you to enter the data to be stored with the block. Y ou can associate
more than one attribute with a block, provided that each attribute has a different tag.

Create a new drawing
Set the following on the Object Propertiestoolbar
e Currentlayer=0
e Color = ByLayer
Circle ! (draw acircle)
e 0,0 + (center point)
» Diameter=50 +
Attdef ! (attribute definition)
« Tag Wdl_ID
*  Prompt: Enter Well Number
o Judtification: Left
* Text Style: Standard
e Height; 75
* Insertion Point: Pick Point
» Pick apoint to the upper right of the circle for attribute text entry
« OK
Save the drawing
e Drawing name: Well
Closethe drawing

Exercise (49)
Inserting a block with attributes.

Create a new drawing (from scratch)
Open the Layer Propertiesdialog box
» Click the“New “ button
» Layer Name: Water_wells
e Layer Color: Blue
e Current layer: Water_wells
Insert <
» Name: Wéll (Click browse and navigate to the drawing created in the previous exercise
e Insertion Point: Click specify on screen
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e Scade(xyz):1

* Rotation: 0

+ Click OK

* Pick apoint to insert well

*  Enter Well Number: 1234
Save the drawing

*  Drawing name: well2
Closethedrawing

86



	XII. Blocks
	BLOCK AND WBLOCK
	To create a block definition
	To save a block or object as a separate drawing file
	Block Objects
	Using Blocks
	Blocks with Attributes
	Exercises

